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Copyright
Suncorp Bank and its vendors own the intellectual property in this Manual exclusively. You acknowledge that you must not 
perform any act which infringes the copyright or any other intellectual property rights of Suncorp Bank or its vendors and 
cannot make any copies of this Manual unless in accordance with these terms and conditions.

Without our express written consent you must not:

•	 �Distribute any information contained in this Manual to the public media or quote or use such information in the public 
media; or

•	 �Allow access to the information in this Manual to any company, firm, partnership, association, individual, group of 
individuals or other legal entity other than your officers, directors and employees who require the information for purposes 
directly related to your business.

License Agreement
The software described in this Manual is supplied under a license agreement and may only be used in accordance with the 
terms of that agreement.

Trademarks
All third-party product and service names are trademarks or registered trademarks of their respective owners.

Suncorp Bank 
GPO Box 1453 
Brisbane QLD 4001 
Phone 13 11 75 
www.suncorpbank.com.au
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Using this Manual
This section contains information that helps you understand and use the information contained in this manual.

Purpose
The Batch Loader is an application facilitating the batched processing of credit card transactions.

This Batch Loader R2.0 User Manual helps end users to understand the installation and operational requirements of the Batch 
Loader application.

Related Documents
This document is intended to be used with reference to various other documents detailing systems that this application 
depends upon. The reader is advised to consult the following documents to gain an in-depth understanding of the application:

Document Name

Merchant Administration Guide

Other Software Dependencies
The Batch Loader depends upon the following 3rd party software:

Software Version URL

Java Runtime Environment SUN JRE 6 http://java.sun.com/

OR OR

Java Development Kit SUN JDK 6

Furthermore, the application requires connectivity to the internet in order to send transactions to the Payment Server.
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Essential Knowledge
Distribution
The Batch Loader installation package is distributed to merchants who have been approved by Suncorp Bank for the batched 
processing of transactions.

Note the Batch Loader installation package must NOT be redistributed without the prior consent of Suncorp Bank.

Functional Overview
The following diagram depicts the communication between the Batch Loader and various components of the MiGS service:

Communication between the Batch Loader and the Server

As the Batch Loader communicates with the server via Virtual POS, the Batch Loader must only use Merchant IDs linked to 
the keys in Virtual POS.

Prerequisites
SUN JRE/JDK must be installed prior to the installation of the Batch Loader. Please refer to the “Related Documents” and 
“Other Software Dependencies” for further information on obtaining and installing this software.

Furthermore, a valid Merchant ID must be active on the MiGS service, with the following “Global Permissions” enabled:

Virtual POS

MOTO

Refunds processing requires an Advanced Merchant Administration username and password.
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Two Step Manual Processing Cycle
VITAL INFORMATION: Merchants operating the Batch Loader application manually must process transactions in a two step 
process:

1.	�Validate Only Cycle – this process prescreens the input file for commonly known errors, and outputs information on which 
transactions are correctly formatted, and which transactions will definitely fail. In the Validate Only Cycle, no transactions 
will be sent to the Payment Server. This allows the merchant to correct formatting errors. Once the user is happy with a 
validated input file, they may proceed to the next step.

Note: the application defaults with the validate only option enabled, however the user may manually skip this step. 
Validation is highly recommended to reduce rework on failed transactions.

Processing Cycle – this process will send transactions to the Payment Server. Any transactions that had failed validation, but 
had not been corrected, will not be sent to the server.

Note: indepth information on using the application will be detailed in the section “Using the Batch Loader”.

Automatic Processing Cycle - Automatic Processing will be covered in the Advanced Section of this manual.

Input and Output File Format
The Batch Loader application processes transaction commands from comma separated value (CSV) input files. Likewise, it 
outputs results to CSV output files.

Input and Output File Locations
The Batch Loader application picks up input files from the following subdirectory:

	 <BATCHHOME>\batchin (by default)

and generates output files in:

	 <BATCHHOME>\batchout(enforced)

where <BATCHHOME> is the directory in which the application has been installed. The user may select input files from other 
directories, however the output files will always be generated in the “batchout” directory.

Validate Only Cycle

In the Validate Only Cycle, users can validate the file, make any adjustments necessary, and validate the file again. There is 
no limit on the number of times a file can be validated.

Note: the output filenames are prefixed with the input filename. This is to allow easy identification of results.
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Processing Cycle

In the Processing Cycle, the file.csv.state file is used to keep track of which lines in the input file.csv has been processed. 
Should the process be interrupted, processed transactions will not be sent again. The program will resume at the first 
unprocessed transaction.

Note: the application keeps track of results and processed transactions via the unique filename. Once the Processing Cycle 
has been initiated, the user MUST NOT CHANGE/DELETE the filenames or contents of the files illustrated above.

The declined file.csv.dec.csv and error file.csv.err.csv files contain declined and error transactions exactly as they appear 
in the input file. The user can make a copy of these files, make any corrections necessary, and reprocess these failed 
transactions. NOTE: it is recommended that the user does not change the declined and error output files, but rather make a 
different copy for reprocessing. The user can copy these files to the input directory and make modifications there.
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Windows Installation
This section contains information on the installation and general configuration of the Batch Loader.

Installation Package
The Batch Loader is distributed via a package named:

	 vpcbatch_<version>_MiGS.exe

where <version> is the current version of the application. To initiate the installation process, doubleclick the installation 
package:

Installation Process

The installation program will begin with an “Introduction” screen. Click Next to proceed.
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A “Choose Java Virtual Machine” screen will be displayed. A list of recognised Java Virtual Machines (JVMs) will be listed.

Note: The correct JVM as specified in the section “Other Software Dependencies” is required.

Click Next to proceed.

A “Choose Install Folder” screen will be displayed. It is recommended that the default folder should be used.  
Click Next to proceed.
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A “Choose Shortcut Folder” screen will be displayed. It is recommended that the default folder should be used.  
Click Next to proceed.

A “Pre-Installation Summary” screen will be displayed. Once the user has checked the settings, click Install to proceed.

A progress screen will be displayed. Please wait while the application is installed.

Once the installation is complete, an “Install Complete” screen will be displayed. Click Done to complete the installation 
process.
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Post-Installation Configuration

All following configurations are done by modifying the ‘BATCHLOADER.properties’ file located in <batchhome>\classes folder 
(default C:\MiGS\VPCBatchLoader\classes)

Please open this file ‘BATCHLOADER.properties’ by using any text editor, such as notepad or wordpad.

1.	Installation Patch setting (You might skip this step, if you install the batch load by using default installation patch.)

	 Look for ‘BATCHLOADER_ROOT’, and input the correct patch for the Batch Loader.

	 Examples

	 BATCHLOADER_ROOT=C:\\MiGS\\BatchLoader

2.	Look for ‘MIGS.TARGETURL’

	 Please mark sure the URL is ‘https://migs.mastercard.com.au/vpcdps’.

	 MIGS.TARGETURL=https://migs.mastercard.com.au/vpcdps

3.	Look for ‘ACCESSCODE’

Please input the Accesscode you retrived from Merchant Administration (MA) portal or from Suncorp Bank.

For detailed information on the settings configurable in the BATCHLOADER.properties configuration file, please refer to 
Appendix A.
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Using the Batch Loader
This section contains information on the operation of the Batch Loader application.

Starting the Batch Loader in Windows
As mentioned in a previous section, the Batch Loader can be started via:

Start -> Programs -> MiGS VPC Batchloader R2.0 -> Load

An “ERRBATCHLOADER” screen will be displayed if there is an error. Please refer to Appendix B.

The Validate Only Cycle
Once the Batch Loader has been successfully started, the main “Loader” screen will be displayed.

The main “Loader” screen is the interface through which the user will carry out the batch processing task. Notice that the 
“Batch File” field is currently blank, and that the “Load” button is disabled.

1. Batch File Input Directory

Batch files should be placed in the following directory:

	 <BATCHHOME>\batchin

This will allow the application to easily locate the batch files to be processed. Although it is not mandatory for batch files to 
be placed in this directory, it is highly recommended so that the user can keep track of all their files.

Note: batch files must have a unique filename. As detailed in the section “Input and Output File Locations”, the application 
keeps results and status information according to the input filename.
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2. Opening a Batch File

To select a batch file, click on the Open button from the “Main Loader” screen. An example batch file is included in the 
installation package. Select the batch file and click the Open button.

3. Ensuring that “Validate Only” is Checked

By default, the Validate Only checkbox is ticked when a batch file is selected. Because this option is selected, no transactions 
will be sent to the server; transactions in the batch file will be checked for common formatting errors.

Notice that the “Batch File” field will display the filename of the selected batch file. Once a batch file has been selected, the 
“Load” button is enabled as illustrated above.
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4. Starting the “Validate Only” Cycle

The validation can be started via the Load button.

The progress will be displayed while validation is taking place.

5. Checking the Results from the “Validate Only” Cycle

Please wait while the application performs validation. Once it is complete, the application will display “FINISHED” in the 
“Status” field. Several results buttons will also be enabled.
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The View All Results button will display the validation status of all transactions contained in the input batch file. This includes 
all validated and error results (file.csv.test.all.csv).

The Validated button will display the validation status of all validated transactions (file.csv.test.app.csv).

The Error button will display the error transactions exactly as it appears in the input batch file (file.csv.test.err.csv).

Please refer to Appendix B and C for detailed information on result codes and result information.

The following is an example of the .all.csv file that is displayed when the View All Results button is pressed.

6. Amending the Input Batch File

The user should take note of any error transactions, and make any modifications necessary. Because this is the “Validate 
Only” cycle, the user may make modifications to the original input batch file.

The user is encouraged to validate the input batch file until the batch file is deemed fit for the “Processing” cycle.

To repeat the “Validate Only” cycle after making modifications, the user should ensure that the Validate Only option is 
selected, and click on the Load button to revalidate.

Note: the most common source of validation errors are fields that are too long / too short, or fields that contain invalid 
information (for example a card number failing MOD10 check).
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The AMA Configuration Screen
If the input batch file contains transactions, such Capture and Refund, requiring “Advanced Merchant Administration” 
usernames and passwords, they can be configured in the “AMA Configuration” screen.

The AMA User can be created by login to Merchant Administration Portal. Please refer to the Merchant Administration Guide 
for more information.

Up to five (5) AMA usernames/passwords can be configured.

The Processing Cycle
Once the user has validated the batch file, they may begin the “Processing” cycle.



18 Suncorp Bank

7. Ensuring that “Validate Only” is Cleared

To start the “Processing” cycle, ensure that the “Validate Only” checkbox is cleared as illustrated below.

Note: by clearing the “Validate Only” checkbox, transactions will be sent to the server when the “Load” button is pressed.

8. Starting the “Processing” Cycle

The processing can be started via the Send File button.



19Virtual POS Batch Loader Manual – August 2013

A confirmation popup for the start of the “Processing” cycle will appear. Click Yes to proceed or No to cancel processing.

9. Waiting for the “Processing” Cycle to Finish

Please wait while the application performs processing. The total time is dependent on the size of the batch file, the speed of 
the computer, the speed of the internet connection, and the authorisation time taken for each transaction.

The processing can be stopped via the Stop button, the File > Exit menu item, or the X at the top right corner of the 
application. If the processing needs to be stopped, please wait patiently while the application finishes off transactions that 
have already been sent to the server.

Note: the application cannot be closed while a batch file is being processed. If the File > Exit menu item, or the X is 
pressed while a batch is being processed, this will be equivalent to pressing the Stop button. To close the application press 
the File > Exit menu item or the X while batch processing has finished or has stopped.

10. Checking the Results from the “Processing” Cycle

Once the “Processing” cycle is complete, the application will display “FINISHED” in the “Status” field. Several results buttons 
will also be enabled.

The View All Results button will display the results of all transactions. This includes all approved, declined, and error results 
(file.csv.all.csv).

The Approved button will display the results of all approved transactions (file.csv.app.csv).

The Declined button will display the declined transactions exactly as it appears in the input batch file (file.csv.dec.csv).

The Error button will display the error transactions exactly as it appears in the input batch file (file.csv.err.csv).

An extra state file (file.csv.state) contains the information on which lines of the input batch file has been processed. This file 
is for the internal use of the application only. PLEASE DO NOT EDIT OR REMOVE THIS FILE, this is especially important 
if the processing was stopped before it was finished, as this file allows the application to resume processing at the last 
unprocessed transaction.
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Business Processes for Declined and Error Transactions

The declined (file.csv.dec.csv) and error (file.csv.err.csv) files contain transactions copied from the input batch file. The exact 
reason for the decline/error should be crosschecked with the results file (file.csv.all.csv) and a business decision be made 
whether to correct and reprocess these transactions.

DO NOT MODIFY THESE FILES DIRECTLY – these files can be copied back into the input directory as a new batch file. 
Please rename it to a unique batch filename.

Refunding Transactions

The approved results file file.csv.app.csv contains the necessary information for processing refunds. DO NOT MODIFY THIS 
FILE DIRECTLY – this file can be copied back into the input directory as a new batch file. Please rename it to a unique batch 
filename.

The “TXNTYPE” field can be changed from a charge to a refund, while the “TRANSACTIONNO” can be used. All other 
irrelevant fields should be removed to conform to the refunds format (see Appendix C).

This section contains information on the uninstallation of the Batch Loader application.

Before Uninstalling the Batch Loader

Note: before uninstalling the Batch Loader please ensure that the batchin and batchout directories (input batch files, and 
output results) are backed up in a safe location.

Uninstalling the Batch Loader in Windows

The Batch Loader can be uninstalled via:

	 Start -> Programs -> BatchLoader -> Uninstall

Follow the onscreen instructions to uninstall the application.
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Advanced Functions
This section contains information on the advanced functions and settings of the Batch Loader application.

Before users attempt to utilise these advance function they should have a good understanding of how the Batch Loader 
functions and the input/output formats.

Automating Batch Loader
•	 By starting the Batch Loader with Load_Auto.exe the Batch Loader will search through the batchin and process all files that 
starts with certain pattern (default is “Auto”).

	 This pattern can be changed/defined in

	 \BatchLoader\classes\BATCHLOADER.properties

	 in the line

	 INPUT_PATTERN=Auto

•	 Next is to add running Load_Auto.exe as a windows scheduled task, please navigate to:

	 Start > All Programs > Accessory > System Tools > Scheduled Tasks

•	 Click on Add Scheduled Task

•	 Click on Next

•	 Click on Browse

•	 Browse to the Batch Loader folder and select Load_Auto.exe

•	 Select desired frequency and time.

	 In the log directory there will be a log file called autotask.log which will have details on the automated tasks.

	 For example:

	 Wed Mar 15 17:40:45 EST 2006 
	 ROOTDIR = C:\MiGS\BatchLoader 
	 INPUT_DIRECTORY = C:\MiGS\BatchLoader\batchin 
	 OUTPUT_DIRECTORY = C:\MiGS\BatchLoader\batchout 
	 INPUT_PATTERN = Auto 
	 VALIDATE_ONLY = false 
	 Ready to process 1 input files 
	 ... Auto Processing 
	 C:\MiGS\BatchLoader\batchin\Auto_sampleStandard01.csv 
	 ... done #0 
	 Finished auto processing

	 Operating in the Background The Batch Loader can be ran hidden automatically.

	 Right click on Load_Auto.exe

	 Select Properties

	 In the “Target:” field, delete the word “show” at the end.

	 Next time the Batch Loader is run from Load_Auto.exe it will start processing without showing its window.

Custom input directory
You can define your own input directory in

	 \BatchLoader\classes\BATCHLOADER.properties

by removing the # infront of the line

	 INPUT_DIRECTORY=C:\\MiGS\\BatchLoader\\MERCHANT_DEFINED
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Recurring Payments
User may send an empty expiry date field if optional expiry date is activated.

For example, a purchase transaction line will be:

	 C,MERCHANTID,MERCHREF,5123456789012346,,123,500,ORDERINF

To activate the optional expiry date, users will have to open the “BATCHLOADER.properties” file in the classes folder; And 
uncomment the line: (take away the #)

	 #RECURPAY_CARDEXP=Optional

During validation, if no Exp Date is specified or it is all “spaces”, it will pass validation. If the exp date has anything other than 
spaces, validation will still check for its formating as per nonrecurring payments.

Note: The merchant account has to be setup by their bank to send “Recurring Transaction Subtype” as default, before they 
can utilise recurring payments. Please consult your bank.
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Appendix A
BATCHLOADER.properties

Below is an example listing for the configuration file.

################################################################################

# Copyright 2007 MasterCard International

# BATCHLOADER.properties - MiGS VPC BatchLoader Configuration File

#

# Lines that are prefixed with “#” are comments lines.

# Lines that are NOT prefixed with “#” are settings lines.

# Lines that appear more than once will take the value furthest down in file.

################################################################################

#-------------------------------------------------------------------------------

# BATCHLOADER_ROOT

# Must be set to the batch installation directory. Note that Windows

# directories are separated by double backslash \\ and there is no trailing \\

# ----------------------------------------------------------------------------

# Examples

# BATCHLOADER_ROOT=C:\\MiGS\\BatchLoader

#-------------------------------------------------------------------------------

BATCHLOADER_ROOT=\\MiGS\\VPCBatchLoader

#-------------------------------------------------------------------------------

# INPUT_DIRECTORY

# User Defined Input Directory, default is “\\BatchLoader\\batchin”

#-------------------------------------------------------------------------------

#INPUT_DIRECTORY=C:\\MiGS\\VPCBatchLoader\\MERCHANT_DEFINED

#-------------------------------------------------------------------------------

# RECURPAY_CARDEXP

# Uncomment the line below and the batchloader will not check the existence

# of the card expiry date. (For recurring payments)

#-------------------------------------------------------------------------------

RECURPAY_CARDEXP=Optional

#-------------------------------------------------------------------------------

# INPUT_PATTERN

# Only batch filenames that starts with the defined INPUT_PATTERN will execute

# when the BatchLoader is in Auto Mode.

#-------------------------------------------------------------------------------

INPUT_PATTERN=Auto
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#-------------------------------------------------------------------------------

# BATCHLOADER_DOFORMAT

# Must be set to the input file format. Refer to documentation for details.

# ----------------------------------------------------------------------------

# Examples

# BATCHLOADER_DOFORMAT=BATCHLINECUSTOM1

# BATCHLOADER_DOFORMAT=BATCHLINESTANDARD

#-------------------------------------------------------------------------------

BATCHLOADER_DOFORMAT=BATCHLINESTANDARD

#BATCHLOADER_DOFORMAT=BATCHLINECUSTOM1

#-------------------------------------------------------------------------------

# BATCHLOADER_CCMASK16

# Masking format for 16 digit card numbers in the “.out.csv” results file

# ----------------------------------------------------------------------------

# Examples

# (DEFAULT) Mask ALL digits

# 0.4 Show only the last 4 digits

# 6.3 Show only the first 6 and the last 3 digits

# 6.4 Show only the first 6 and the last 4 digits

# NONE No masking, display all digits

#-------------------------------------------------------------------------------

BATCHLOADER_CCMASK=6.3

#-------------------------------------------------------------------------------

# AMA Username and Password Configuration

# Preset the AMA merchant ID and usernames for refunds processing

# ----------------------------------------------------------------------------

# Examples

# BATCHLOADER_AMA_MERCHANT1_ID=TESTMERCHANT1

# BATCHLOADER_AMA_MERCHANT1_USER=user1

#-------------------------------------------------------------------------------

BATCHLOADER_AMA_MERCHANT1_ID=TESTMERCHANT1

BATCHLOADER_AMA_MERCHANT1_USER=AMA

BATCHLOADER_AMA_MERCHANT1_PASS=password123

BATCHLOADER_AMA_MERCHANT2_ID=TESTMERCHANT2

BATCHLOADER_AMA_MERCHANT2_USER=user2

BATCHLOADER_AMA_MERCHANT3_ID=TESTMERCHANT3

BATCHLOADER_AMA_MERCHANT3_USER=user3

BATCHLOADER_AMA_MERCHANT4_ID=TESTMERCHANT4

BATCHLOADER_AMA_MERCHANT4_USER=user4

BATCHLOADER_AMA_MERCHANT5_ID=TESTMERCHANT5

BATCHLOADER_AMA_MERCHANT5_USER=user5
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################################################################################

# THE FOLLOWING FIELDS MUST NOT BE CHANGED

################################################################################

BATCHLOADER_ECHO=BATCHLOADER_ECHO

BATCHLOADER_NAME=MiGS VPC Batch Loader

BATCHLOADER_VERSION=R2.0

################################################################################

# UNUSED SETTINGS

################################################################################

#BATCHLOADER_COMPILATION=WIN32

#--- LOGGING -------------------------------------------------------------------

#--- WARNING: DO NOT CHANGE THESE VALUES AS THIS MAY LEAD TO LOGGING FAILURE.

log4j.rootCategory = DEBUG, MIGSAPPENDER

log4j.appender.MIGSAPPENDER=org.apache.log4j.ConsoleAppender

#log4j.appender.MIGSAPPENDER=org.apache.log4j.DailyRollingFileAppender

log4j.appender.MIGSAPPENDER.layout=org.apache.log4j.PatternLayout

log4j.appender.MIGSAPPENDER.layout.ConversionPattern=%d{yyyy-MM-dd HH:mm:ss.SSS} %-5p %c{1} %m%n

#-------------------------------------------------------------------------------

# TARGET URL

# The VPC Batchloader no longer relies on the Payment Client to point to the

# desired URL. This configuration defines where you are sending the batch transactions

#-------------------------------------------------------------------------------

#MIGS.TARGETURL=https://

MIGS.TARGETURL=https://migs.mastercard.com.au/vpcdps

#-------------------------------------------------------------------------------

# ACCESSCODE

# Every MerchantID will have their unique Access Code. It can be retrieved from

# your Merchant Administration Portal.

# ----------------------------------------------------------------------------

# Examples

# ACCESSCODE=A605VBD4

#-------------------------------------------------------------------------------

ACCESSCODE=<your Accesscode here>
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Appendix B
This section contains detailed information on RESULTCODEs displayed by the Batch Loader application.

ERRBATCHLOADER (BatchLoader Configuration Errors)
ERRBATCHLOADER error messages typically depict configuration errors of the application. With the exception of L000 and 
L001, these errors will prevent the application from processing the batch file.

Info Description / Resolution

B000 Could not find the Payment Client. Please check the “lax.class.path” setting in the Load.lax file, or check 
your CLASSPATH environment variable.

B001 BATCHLOADER.properties configuration problem

B002 A lock file indicates that the application is already running. Only one instance of the Batch Loader can 
run at any one time. The lock file may have been left behind by a previous crash. If you are 100% sure 
no other instances of the Batch Loader is running, you may remove the BATCHLOADER.lock file from the 
“log” directory and restart the application.

B003 Unable to create “.state” file. Please check that the files in “batchout” are not writeprotected, and that 
you have read/write access to the “batchout” directory.

B004 There is a problem with the selected batch file. Please check that the file exists, and that you have read 
access to the file, and that it is a supported batch file type.

B005 There is a problem with the selected batch file. Please check that the file exists, and that you have read 
access to the file, and that it is a supported batch file type.

B006 Unable to create “.all.csv” file. Please check that the files in “batchout” are not writeprotected, and that 
you have read/write access to the “batchout” directory.

B007 Unable to create “.app.csv” file. Please check that the files in “batchout” are not writeprotected, and that 
you have read/write access to the “batchout” directory.

B008 Unable to create “.dec.csv” file. Please check that the files in “batchout” are not writeprotected, and that 
you have read/write access to the “batchout” directory.

B009 Unable to create “.err.csv” file. Please check that the files in “batchout” are not writeprotected, and that 
you have read/write access to the “batchout” directory.

L000 No AMA username specified for this merchant ID. This is returned in the RESULTCODE and RESULTINFO 
field during validation or processing. Please configure the appropriate MerchantID/username/password in 
the AMA Configuration screen.

L001 Invalid BATCHLOADER_DOFORMAT specified in the configuration file BATCHLOADER.properties. This is 
returned in the RESULTCODE and RESULTINFO field during validation or processing. Please ensure that a 
correct value has been configured, and close and restart the application.
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ERRRECORD (Batch File Record Errors)
ERRRECORD error messages indicate formatting errors in a particular transaction line in the input batch file.

During the “Validate Only” cycle, validated transactions will be marked as “VALIDATED”, otherwise the suitable ERRRECORD 
will be recorded.

During the “Processing” cycle, all transactions marked with ERRRECORD will be stopped by the application and will not be 
sent to the server.

Info Description / Resolution

R000 Blank line – indicates a blank line in the batch file.

R010 Input TXNTYPE is invalid. Check the error message for details.

R011 Input MERCHANTID is invalid. Check the error message for details.

R012 Input MERCHTXNREF is invalid. Check the error message for details.

R013 Input CARDNUM is invalid. Check the error message for details.

R014 Input CARDEXP is invalid. Check the error message for details.

R015 Input CARDCSC is invalid. Check the error message for details.

R016 Input AMOUNT is invalid. Check the error message for details.

R017 Input ORDERINFO is invalid. Check the error message for details.

R018 Input TRANSACTIONNO is invalid. Check the error message for details.

ERRPC (Payment Client Errors)
ERRPC error messages will only occur during the “Processing” cycle. ERRPC messages indicate that the formatting of the 
particular transaction line has been validated, and has been passed to the Payment Client, however an error has occurred at 
the Payment Client. Typical errors include nonexistent MERCHANTIDs, internet connection errors, amongst others.

Please check the Payment Client documentation for a full listing of Payment Client Errors. 
APPROVED / DECLINED

Transactions that have successfully reached the authorisation process will have a RESULTCODE of APPROVED or 
DECLINED.

Resultcode Description

APPROVED Transaction has gone through authorisation and has been approved.

DECLINED Transaction has gone through authorisation and has been declined.
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Appendix C
This section contains information on the input file formats supported by the Batch Loader application.

BATCHLINESTANDARD
The input file format is specified in the BATCHLOADER.properties configuration file. To use the “BATCHLINESTANDARD” file 
format, the following must be configured:

	 BATCHLOADER_DOFORMAT=BATCHLINESTANDARD

BATCHLINESTANDARD – Charge – Input Format

# Input field Required Min 
Chars

Max 
Chars

Comments

1 TXNTYPE Y 1 1 Must be “C” for MOTO transactions.

2 MERCHANTID Y 1 16 Provided merchant ID.

3 MERCHTXNREF N ~ 40 Merchant generated unique reference.

4 CARDNUM Y 13 19
Card number to be charged. BatchLoader will do 
MOD10 check.

5 CARDEXP Y 4 4 Format YYMM. MM is checked to be <= 12.

6 CARDCSC N ~ 4 Card Security Code (CVC2/CVV2).

7 AMOUNT Y 1 10 In CENTS (e.g. $1 = 100). Must not be <= 0.

8 ORDERINFO Y 1 34 Merchant generated reference.
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# Output Field Comments

1 RESULTCODE Result of the transaction.

2 RESULTINFO Detailed information of the results.

3 TXNTYPE same as input

4 MERCHANTID same as input

5 MERCHTXNREF same as input

6 CARDNUM same as input (may be masked if configured).

7 CARDEXP same as input

8 CARDCSC always masked

9 AMOUNT same as input

10 ORDERINFO same as input

11 QSIRESPCODE Receipt QSI Response Code

12 QSIRESPCODEDESC Receipt QSI Response Code Description

13 AMOUNT Receipt Authorized Amount

14 RECEIPTNO Receipt Receipt Number

15 ACQRESPCODE Receipt Acquirer Response Code

16 AUTHORIZEID Receipt Authorization ID

17 BATCHNO Receipt Settlement Batch Number

18 TRANSACTIONNO Receipt Shopping Transaction No

19 CARDTYPE Receipt Recognized Card Type

*Note: error transactions (that are not sent to the server) may not contain receipt fields 1119.

BATCHLINESTANDARD – Refund – Input Format

# Input field Required Min 
Chars

Max 
Chars

Comments

TXNTYPE Y 1 1 Must be “R” for refund transactions.

MERCHANTID Y 1 16 Provided merchant ID.

MERCHTXNREF N ~ 40 Merchant generated unique reference.

TRANSACTIONNO Y 1 19 Shopping Transaction No from a previous Charge 
transaction.

AMOUNT Y 1 34 In CENTS (e.g. $1 = 100). Must not be <= 0.
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BATCHLINESTANDARD – Refund – Output Format

# Output Field Comments

1 RESULTCODE Result of the transaction.

2 RESULTINFO Detailed information of the results.

3 TXNTYPE same as input

4 MERCHANTID same as input

5 MERCHTXNREF same as input

6 TRANSACTIONNO same as input

7 AMOUNT same as input

8 BLANK blank field

9 BLANK blank field

10 BLANK blank field

11 QSIRESPCODE Receipt QSI Response Code

12 QSIRESPCODEDESC Receipt QSI Response Code Description

13 BLANK blank field

14 RECEIPTNO Receipt Receipt Number

15 ACQRESPCODE Receipt Acquirer Response Code

16 AUTHORIZEID Receipt Authorization ID

17 BATCHNO Receipt Settlement Batch Number

18 TRANSACTIONNO Receipt Financial Transaction No

19 BLANK blank field 

*Note: error transactions (that are not sent to the server) may not contain receipt fields 1119.

BATCHLINESTANDARD – Example
A sample batch file is supplied with the Batch Loader. The following is an example of the BATCHLINESTANDARD charge 
input format.

C,TESTTESAUDALUCYF,MERCHTXNREF01,5123456789012346,0504,123,100,ORDERINFO01 
C,TESTTESAUDALUCYF,MERCHTXNREF02, 4005550000000001,0504,1234,100,ORDERINFO02 
C,TESTTESAUDALUCYF,MERCHTXNREF03,5123456789012346,0504,123,100,ORDERINFO03
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Contact us for more information  
or to change your details:

	 Call 13 11 75 

	 suncorpbank.com.au

	 	 Visit your local branch or agency

	 	 Mail to GPO Box 1453, Brisbane QLD 4001

	 	 Fax 07 3031 2250

Suncorp-Metway Limited ABN 66 010 831 722


